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Changes, Defects & Issues

In the course of your team's work on a model, changes and issues can arise at a number of levels, for problems that apply
system-wide through areas of the model and down to within a specific element. A Change, very broadly, defines an
addition or alteration to a requirement, whilst an Issue identifies either a failure to meet a requirement, or a risk in
meeting the requirement.
There are two mechanisms that can be used to identify a change or issue, and the work required to resolve it:

·

Change and Issue (or Defect) elements - structured comments that identify a problem at system-level, although they
can also be attached to a specific element from which a problem arises; both types of element can be linked by
relationships such as Association, Dependency and Realize to one or more other elements that have to be reviewed,
and for complex problems can form hierarchies or groups

·

Maintenance items - properties raised against a specific element and recorded for that element in the Maintenance
window; these provide a distinction between Defects (a failure to meet a requirement) and Issues (a risk factor that
might affect satisfying the requirement) and also include Tasks, which record work items associated with the
element
Maintenance items are very specific, but if an item begins to have a wider impact on other elements or the system in
general, you can translate that item into a Change, Issue, or any other type of element that best identifies the problem
and its solution

Maintenance items are defects, changes, issues, tasks, features and documents that apply at the model element level.
They are properties of individual model elements that can be used to record and capture problems, changes, issues and
tasks as they arise, and document the solution and associated details.

Maintenance Tasks
Task Area
Maintenance Items Element-level

Creating and Editing
Maintenance Items
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Detail
You create maintenance items in the Maintenance window. Typically you create:

·

A defect to record a failure to meet a requirement for the current model
element

·
·

A change to record a change in requirement for the current model element

·

A task to record work in progress and work outstanding for the current model
element

·
·

A feature to record a feature in requirement for the current model element

An issue to record a risk factor that might affect the project being recorded for
the current model element

A document to record supporting documentation such as Help, release notes
and user comments

Tasks that you might perform when working with maintenance items include:

·
·
·
·

Moving or copying maintenance items between maintenance types
Generating new items of one type from an item of a different type
Creating elements from maintenance items
Showing maintenance items on elements in a diagram
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·
·
Maintenance System-level

Adding a maintenance item directly to an element via in-place editing
Generating a report on the status of maintenance items of specific types or all
types

To represent changes, defects and issues that apply to the model you can create
Change and Issue elements with - if necessary - subordinate structures.
To represent issues and tasks that apply to the progress of the project as a whole
and that are not related to model structures, you create Project Issue and Project
Task records in Project Management.
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Maintenance Overview
If your work in managing a project identifies issues, defects or required changes in the model rather than internal to a
single element, you can represent these using Change, Issue or Defect elements as structured comments with which you
can track and manage the problems.

·
·

A Change element corresponds to a change in requirements for the current system

·

A Defect element corresponds to a failure to match the requirements for the current system due to a flaw in the
model, system or process, such as a missing element or module, or no inclusion of a necessary actor

An Issue element corresponds to a failure to match the requirements for the current system due to newly arisen
organizational or legal factors such as staffing problems, changes in laws or guidelines, or business unit restructuring

You can also define any specific work to be done in researching or resolving the problem using Task elements, and
assign resources to these or directly to the Change, Issue or Defect elements internally, in Resource Allocation, or
externally as Actors.
The use of maintenance elements provides a broad scope for managing changes, defects and issues, providing the facility
to fully define the problem and its resolution with Linked Documents, both internal and external Notes, and Composite
Structure diagrams including Interaction and Activity diagrams.
You can create Change, Defect and Issue elements in various UML diagrams (especially Maintenance diagrams) and
connect them using Realization, Dependency, Aggregation and other relationships to show what model elements each
problem affects and how each is resolved. Within the element 'Properties' dialog for Changes, Defects and Issues you can
identify the problem as the element name and record relevant management details, such as owner and dates.
A useful tool in managing problems and changes is the Relationship Matrix, in which you might - for example - link staff
(Actors) through Realization connectors to Issues. Each highlighted square in the Matrix indicates the responsibility of a
staff member to work on or correct a named Issue.
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Issues
In your modeling, issues concerning the development of the system or model might arise; more formally, you encounter
a failure to meet defined requirements for the current system. You can represent this failure using an Issue element,
which is a structured comment containing information about the issue and the measures taken to manage it. The element
is rendered as shown.

You can link Issues to model elements that are responsible for the issue, using Realize connectors. You can also create a
hierarchy of related Issues using Aggregation connectors. Each Issue element has a status band at the left end, which is
color coded to visually represent the value of the 'Status' field in the element properties. The element has an identifying 'I'
in the top right corner, which you can hide if you prefer not to show it.
You can create Issue elements on most types of diagram, although the Maintenance diagram is specifically designed for
displaying and managing them. You can also create your own issue-management diagram as a Custom diagram. You can
add the Issue (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the Browser
window.

Add an Issue to the model using the Toolbox
Step

Action

1

Open the Maintenance or Custom (or other) diagram to define the problem.

2

From the 'Custom' pages or 'Common' page of the Diagram Toolbox, drag the Issue icon onto the diagram.

3

If the Properties window is not already displayed, press Ctrl+2 on the element. Record the name and
details of the Issue, in the Properties window.

Add an Issue to the model using the 'New Element' dialog
Step
1

Action
Identify the Package in which to record the Issue, in the Browser window.
Right-click on this Package and select the 'Add Element' option.

2

Complete the fields on the 'New Element' dialog - in the 'Type' field, click on the drop-down arrow and
select 'Issue'.

3

When you have created the element, record the name and details of the Issue, in the Properties window.

Notes
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To toggle display of the letter 'I' in the top right corner of the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Defects
In your modeling, problems in the development of the system or model might arise; more formally, you encounter an
obstacle to meeting defined requirements for the current system, through a defect of the model, system or process. You
can represent this failure using a Defect element, which is a structured comment containing information about the defect
and the measures taken to manage it. The element is rendered as shown.

You can link Defects to model elements that are responsible for the problem, using Realize connectors. You can also
create a hierarchy of related Defects using Aggregation connectors. Each Defect element has a status band at the left end,
which is color coded to visually represent the value of the 'Status' field in the element properties. The element has an
identifying 'D' in the top right corner, which you can hide if you prefer not to show it.
You can create Defect elements on most types of diagram, although the Maintenance diagram is specifically designed for
displaying and managing them. You can also create your own defect-management diagram as a Custom diagram. You
can add the Defect (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the
Browser window.

Add a Defect to the model using the Toolbox
Step

Action

1

Open the Maintenance or Custom (or other) diagram to define the problem.

2

From the 'Custom' pages of the Diagram Toolbox, drag the Defect icon onto the diagram.

3

If the Properties window is not already displayed, press Ctrl+2. Record the name and details of the Defect,
in the Properties window.

Add a Defect to the model using the 'New Element' dialog
Step
1

Action
Identify the Package in which to record the Defect, in the Browser window.
Right-click on this Package and select the 'Add Element' option.

2

Complete the fields on the 'New Element' dialog - in the 'Type' field, click on the drop-down arrow and
select 'Defect'.

3

When you have created the element, record the name and details of the Defect, in the Properties window.

Notes
·

To toggle display of the letter 'D' in the top right corner of the element, select or deselect the 'Show stereotype icon
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for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Changes
In your modeling it might become necessary to change an aspect of the system or model; more formally, you need to
request and manage a change in the defined requirements for the current system. You can represent this change request
using a Change element, which is a structured comment containing information about the change and the measures taken
to manage it. The element is rendered as shown.

You can link Changes to model elements that are impacted by the change, using Realize connectors. You can also create
a hierarchy of related Changes using Aggregation connectors. Each Change element has a status band at the left end,
which is color coded to visually represent the value of the Status field in the element properties. The element has an
identifying C in the top right corner, which you can hide if you prefer not to show it.
You can create Change elements on most types of diagram, although the Maintenance diagram is specifically designed
for displaying and managing them. You can also create your own change-management diagram as a Custom diagram.
You can add the Change (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the
Browser window.

Add a Change to the model using the Toolbox
Step

Action

1

Open the Maintenance or Custom (or other) diagram in which to define the problem.

2

From the 'Custom' or 'Common' pages of the Diagram Toolbox, drag the Change icon onto the diagram.

3

If the Properties window is not already displayed, press Ctrl+2. Record the name and details of the
Change, in the Properties window.

Add a Change to the model using the 'New Element' dialog
Step
1

Action
Identify the Package in which to record the change, in the Browser window.
Right-click on this Package and select the 'Add Element' option.

2

Complete the fields on the 'New Element' dialog - in the 'Type' field, click on the drop-down arrow and
select 'Change'.

3

When you have created the element, record the name and details of the Change, in the Properties window.

Notes

(c) Sparx Systems 2022
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To toggle display of the letter 'C' in the top right corner of the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Maintenance Diagram
A Maintenance diagram is a type of Custom diagram, an extension to the UML model. It is a change management tool,
used to record:

·
·
·

Requests for change to the model structure or project process, as Change elements
Issues that impact the development and progress of the project, as Issue elements, and
Groups of tests that can be applied to many elements rather than specific elements, as Test Cases

Each Change, Issue or Test Case element can link to other model elements in the project, to illustrate how they
contribute to or are impacted by the item, and how they must be modified, removed, applied or extended to provide a
solution. This includes identifying areas of work, represented by Task elements, to which resources can be allocated as
either external (Actor) elements or internal properties (resource allocation).
You generate Maintenance diagram elements and connectors from the 'Maintenance' pages of the Diagram Toolbox,
although you might also make frequent use of connectors from other pages.

Example Diagram
Example Maintenance Diagram

Maintenance Diagram Element Toolbox Icons
Icon

Description
A Package is a namespace as well as an element that can be contained in other
Package's namespaces.
Issue elements represent a failure to meet defined requirements for the current
system.
This element represents a change in the defined requirements for the current system
and can be used to request and manage the change process.
A Task element represents a task that must be performed in relation to an element.
A Test Case is a stereotyped Use Case element. You might use it to extend the
facilities of the Test Cases window, by applying element properties and capabilities
to the tests of a feature represented by another element or - more appropriately - set
of elements.
An Entity is a stereotyped Object that models a store or persistence mechanism that
captures the information or knowledge in a system.
A Test element represents a step in the Basic, Alternate and Exception Paths of a
Scenario created in a Use Case or other element.
The defect element represents an obstacle to meeting defined requirements for the
current system.
The Review element acts as a focus for performing a formal review of one or more
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model elements. It defines the parameters of the review.

Maintenance Diagram Connector Toolbox Icons
Icon

Description
An Aggregation connector is a type of association that shows that an element
contains or is composed of other elements.

(c) Sparx Systems 2022
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Example Maintenance Diagram
Very simply, this example diagram depicts a request for a change (C) to a process represented by an Activity element
(Transfer WH Receipts to Active Stock). The change currently involves the Task (T) of reviewing the interface between
two recording systems, one of which could be affected by an Issue (I) concerning an external stocktaking system.
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Working with Maintenance Items
Creating, viewing and modifying the Maintenance items - changes, issues, defects, tasks, feature and documents associated with a particular model element is quick and convenient, using the Maintenance window. If the Maintenance
window is open, when you select an element in a diagram or in the Browser window, the appropriate maintenance items
for that element are immediately listed in the window, and you can select them there to modify. The Maintenance
window provides several facilities for managing the maintenance items.
You can include the maintenance items in the document and web reports generated on your model. The 'Document Setup'
dialog has checkboxes to show or hide element maintenance items.

Access
Click on an element in the Browser window or diagram and select the appropriate option.
Ribbon

Construct > Change Management and:

·
·
·
·
·
·
Keyboard Shortcuts

> Features > Show Features Window
> Changes > Show Changes Window
> Documents > Show Documents Window
> Issues > Show Issues Window
> Tasks > Show Tasks Window
> Defects > Show Defects Window

Ctrl+8 | <Required tab>
Select any of the items on a diagram or the 'Details' tab of the Inspector window,
then use Shift+Enter

Facilities
Facility
Maintenance Item Types

Detail
The six types of Maintenance Item you can create records for are each listed on a
separate tab of the Maintenance window:

·

Defects - each recording a failure to meet a requirement for the current model
element

·

Changes - each recording a change in requirement for the current model
element

·

Issues - each recording a risk factor that might affect the project, associated
with the current model element

·

Tasks - each recording work in progress and work outstanding for the current
model element

·

Features - each recording a feature in requirement for the current model
element

·

Documents - each recording the supporting documentation such as Help,
release notes and user comments

There is also a 'Maintenance Overview' tab that displays a read-only list of all the
Maintenance items on the element, grouped by type. If you double-click on an item
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in this list, the appropriate tab displays with the item highlighted.

Adding New Items

To add new items, right-click on the main panel of the Maintenance window and
select the 'Add New' option. The appropriate fields for the item type are displayed
on the '<Maintenance Item Type> details for <element>' dialog, where you create
the item.
The fields you complete for each type of maintenance item are very similar.

Applying Automatic
Naming/Numbering

On the '<Maintenance Item Type> details for <element>' dialog, you can apply an
automatic naming/numbering convention that you have previously defined, to each
new item record. To do this, simply click on the Auto button next to the 'Detail'
field.
If you already have some text in the 'Detail' field, it is over-written by the
auto-counter text.

Details tab

Move items between
elements

You can also use the 'Details' tab of the Inspector window to create, select and
display specific items on the '<Maintenance Item Type> details for <element>'
dialog. Select the 'Start > Application > Design > Inspector' ribbon option to open
the Inspector window, select the 'Details' tab and the 'Maintenance > <maintenance
type>' list, and either:

·

Double-click on an existing item to show and - if necessary - change the
details, or

·

Right-click on the appropriate '<maintenance type>' folder name and select the
'New <item type>' option to create a new item

You might have a maintenance item on one element that can be usefully moved on
to another element. You can move the item very simply, by dragging it from the
Maintenance window or 'Details' tab onto the target element on a diagram.

Notes
·

Columns in the item list can be reorganized, added, removed, grouped, filtered and sorted using the options provided
in the List Header facilities

(c) Sparx Systems 2022
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Create Maintenance Items
When you need to create a new maintenance record for an element, you can do so by selecting the 'Add New' context
menu option in the Maintenance window.

Access
Use one of the access paths outlined here to display first the Maintenance window at the appropriate tab for the type of
maintenance item to create, then the '<Maintenance Item Type> details for <element type>' dialog for that item type.
Ribbon

Construct > Change Management > Features > Show Features Window >
right-click | Add New
Construct > Change Management > Changes > Show Changes Window >
right-click | Add New
Construct > Change Management > Documents > Show Documents Window >
right-click | Add New
Construct > Change Management > Issues > Show Issues Window > right-click |
Add New
Construct > Change Management > Defects > Show Defects Window > right-click |
Add New
Construct > Change Management > Tasks > Show Tasks Window > right-click |
Add New

Keyboard Shortcuts

Ctrl+8 > <required tab> | Right-click | Add New
Select any of the Maintenance items on a diagram or on the 'Details' tab of the
Inspector window, then press Shift+Enter

Create Maintenance items on the Maintenance dialog
Option

Action

Detail

Type the name or a short description of the feature, change, defect, task, issue or
document.

Auto

As an alternative to typing in the name, click on this button to insert predefined
auto-counter text.
If you already have some text in the 'Detail' field, it is over-written by the
auto-counter text.

Reported by / Requested by
/ Raised by

Click on the drop-down arrow and select the user name of the person who initiated
the maintenance item.
Alternatively, start typing in the user name until the auto-complete facility fills in
the rest of the name.

Date

(c) Sparx Systems 2022

Defaults to today's date as the date on which the maintenance item was raised; if
necessary, change this by clicking on the drop-down arrow and selecting a different
date.
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Status

Click on the drop-down arrow and select the appropriate status of the maintenance
item, such as 'New' or 'Complete'.

Priority

Click on the drop-down arrow and select the priority for completing the
maintenance item.

Resolved by / Implemented
by / Completed by

Click on the drop-down arrow and select the user name of the person who
completed and closed the maintenance item.
Alternatively, start typing in the user name until the auto-complete facility fills in
the rest of the name.

Date

Select the date on which the maintenance item was completed; click on the
checkbox to select today's date or, if necessary, change the field by clicking on the
drop-down arrow and selecting a different date.

Version / ID

Displays the version number assigned to this defect, change, task, issue or
document.
If you want to refer to this maintenance item from another element or document,
click on the Copy button to copy the ID to the clipboard, from where it can be
pasted into the other text.

Description

Type a longer description of the maintenance item; you can format the text using
the Notes toolbar at the top of the field. The text you enter here is also displayed
and can be edited in the Notes window.

History

Over time, enter any notes on the actions concerning this maintenance item; you
can format the text using the Notes toolbar at the top of the field. The text you enter
here is also displayed and can be edited in the Notes window.

Apply

Click on this button to save the record data and keep the dialog open.

OK

Click on this button to save the record data and close the dialog.

Close

Click on this button to discard the unsaved record data and close the dialog.

New

Click on this button to clear the dialog fields ready to define a new maintenance
item.

left chevron/right chevron

If there are existing items, click on these buttons to display the details of the
previous item or next item in the sequence.

Create Maintenance Items on the Maintenance Window
An alternative method of creating simple Maintenance items is to display the Maintenance window as indicated in the
Access section, but complete the fields on the window rather than go on to display the 'Maintenance' dialog. In this way
you can quickly create a set of basic Maintenance items at once and then add more detail to individual items as necessary
at a later time.
To create an item:
1.

Display the appropriate tab for the type of item.

2.

Double click on the Add new <item type> text and type in the name of the item.

(c) Sparx Systems 2022
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3.

Tab to the 'Status' field; the 'Status', 'Priority' and 'Date Reported' fields display default values. If these are acceptable
to you, the Maintenance item is created and available for future editing.

4.

If you want to change the field values, click once on the field and once on the drop-down arrow, and select the
appropriate value.

Notes
·

To edit an item, double-click on it on the Maintenance window; the item details display in the '<Maintenance Item
Type> details for <element type>' dialog for editing

·

To delete an item, right-click on it on the Maintenance window and select the 'Delete' option; in response to the
confirmation prompt, click on the Yes button

·

A further possibility for editing and deleting items is to right-click on items in the 'Details' tab of the Inspector
window and select menu options there; select the 'Start > All Windows > Design' ribbon option and then 'Explore >
Inspector > Details > Maintenance > <maintenance type>'

·

To change the element for which to create or edit maintenance items, click on the new element on a diagram or in
the 'Project' tab of the Browser window

(c) Sparx Systems 2022
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Properties Window for Maintenance Items
When the Properties window is open, it displays the properties of the selected object or assigned item, including a
Maintenance record for an element. These items include Changes, Issues, Defects, Tasks, Features and Documents.
You might select the item in the appropriate tab of the Maintenance window, the maintenance compartment of an
element on a diagram, or the 'Details' tab of the Inspector window.
The Properties window identifies the type of item just under the toolbar, and shows the current values for the:

·
·
·
·
·
·
·
·

Item name
User who raised the item
Date the item was raised
Status
User who implemented or resolved the item
Date that action was completed
Priority of the item
Version of the item

You can change the value for each of these fields (except for the 'Name' and 'Version' fields), by clicking on the
drop-down arrow and selecting a new value. For the user name fields, you can also start typing in the name until the
auto-complete facility fills in the rest of the name.
For the 'Name' field, you can either overtype the item name or click on the
icon and apply any autonaming
convention you have configured for maintenance items. If you click on the icon for the 'Version/ID' field, that value is
copied to the clipboard to be pasted into a discussion or document.
The toolbar options operate on the parent element for the maintenance item. Any changes you make are automatically
saved and displayed elsewhere when you click off the field.

(c) Sparx Systems 2022
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Move or Copy Maintenance Items Between Types
After you define a maintenance item of one type (Defect, Change, Issue, Document, Feature or Task), you might decide
that the item either is better suited to another type or forms a good template for items of other types. If so, you can either
move or copy the item to the other types.

Access
Display the Maintenance window using one of the methods outlined here.
In the Maintenance window:

·
·

Right-click on a maintenance item | Move to | <item type> or
Right-click on a maintenance item | Copy to | <item type>
Ribbon

Construct > Change Management > Features > Show Features Window
Construct > Change Management > Changes > Show Changes Window
Construct > Change Management > Documents > Show Documents Window
Construct > Change Management > Issues > Show Issues Window
Construct > Change Management > Tasks > Show Tasks Window
Construct > Change Management > Defects > Show Defects Window

Keyboard Shortcuts

Ctrl+8 > <required tab>

Move or copy a maintenance item
Step
1

Action
Click on the appropriate option - 'Move to' or 'Copy to'.
A list of maintenance item types displays.

2

Click on the item type to which to move or copy the item.
A confirmatory prompt displays.

3

Click on the Yes button to confirm the move or copy.

4

Switch to the appropriate tab of the Maintenance window to ensure that the item has been added.

5

If you are copying the item to more than one other item type, repeat steps 1 to 4 for the next item type to
copy to.
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Show Maintenance Items in Diagram
When you have created a maintenance item, it is useful to make the record visible on its parent element. You can do this
by displaying the record within a maintenance compartment on the element as it displays in a diagram. Any element that
is capable of displaying a compartment, and that has maintenance items assigned to it, can show the items in a diagram.

Show maintenance items in a diagram
Step

Action

1

Open a diagram containing the element with the attached maintenance items.

2

Double-click on the diagram background to display the diagram 'Properties' dialog.
Click on the 'Elements' tab.

3

In the 'Show Compartments' panel, select the 'Maintenance' checkbox.

4

Click on the OK button to save the setting.
Each maintenance item now appears in the maintenance compartment of the diagram element. Items of
each type are grouped together so that, for example, all Issues on the element are grouped under the
heading 'Issue', and all Tasks on the element are grouped under the heading 'Task'.
If you double-click on a maintenance item, the '<maintenance item type> for <element>' dialog displays
and you can edit the details of the item.

Maintenance Compartment - Example

(c) Sparx Systems 2022
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Move Maintenance Items Between Elements
A maintenance item you define for one element might be usefully moved to another if, for example, you are moving your
model through stages in a lifecycle or, indeed, modeling a lifecycle. It is possible to simply drag a maintenance item of
any type from either the appropriate tab of the Maintenance window or the 'Details' tab of the Inspector window, onto a
different element on a diagram.

Access
From the Browser window, open the diagram containing the target element, then click on the element from which to
move the tests. It is convenient to have both source and target elements on the same diagram, but it is possible to select
the source element in the Browser window or on a different open diagram.
It is also convenient to have compartments enabled on the target element, with the Maintenance compartment selected,
so that you can observe the addition of the moved item. (Right-click on the element and select 'Compartment Visibility',
then select the 'Maintenance' checkbox.)
Ribbon

Start > Application > Design > Browser > Element - expand the 'Maintenance'
category or
Construct > Change Management > <item type> | Show <item type> Window

Keyboard Shortcuts

Alt+2 | Maintenance > <item type> tab
Click on the source element on a diagram : T

Move the Item to the Target Element
Click on the maintenance item that you intend to move, and simply drag it onto the target element. The item name will
display in the 'maintenance' compartment of that element. What you would observe might resemble this illustration.
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Create Elements From Maintenance Item
A maintenance item identifies a defect, change, issue, task, feature or document concerning an element. The maintenance
item could itself be represented by an element if it has wider implications for the project or identifies - for example - an
actor, activity or action that requires further definition.
You can create one or more elements from any maintenance item, using the Maintenance window. The new element is
connected to the maintenance item's parent element by a Dependency connector. The original maintenance item remains
unchanged as a characteristic of its parent element.

Access
Use one of the methods outlined here to display the Maintenance window appropriate to the maintenance item from
which to create a model element.
In the Maintenance window: Right-click on the maintenance item > Create as New Element
The 'New Element' dialog displays.
Ribbon

Construct > Change Management > Features > Show Features Window
Construct > Change Management > Changes > Show Changes Window
Construct > Change Management > Documents > Show Documents Window
Construct > Change Management > Issues > Show Issues Window
Construct > Change Management > Tasks > Show Tasks Window
Construct > Change Management > Defects > Show Defects Window

Keyboard Shortcuts

Ctrl+8 > <required tab for item type>
Select any of the Maintenance items on a diagram or in the 'Details' tab of the
Inspector window, then press Shift+Enter

Create an element from a maintenance item
On the 'New Element' dialog, complete the fields.
Field/Option

Action

Toolset

The two 'Toolset' fields default to the last-set domain and Perspective. If these are
not appropriate to this task, click on the drop-down arrows and select the correct
domain and Perspective.

Name

The 'Name' field defaults to the name of the Maintenance item. If necessary you can
overtype it with a different name, or click on the Auto button to apply a name from
your auto naming and numbering system.

Type

Click on the drop-down arrow and select the required element type; you might
create:

·
·
·
·
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An Issue element for an Issue maintenance item
A Defect element for a Defect maintenance item
A Change element for a Change or Feature maintenance item, or
A Task for a Task maintenance item
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The types are filtered by the Toolset you have selected; if the element type you
require is not listed, you can change the Toolset to provide that type. You can,
therefore, create a wide range of other element types should any of these be more
appropriate.

Stereotype

If you require the element type you have selected to be refined by a stereotype,
click on the drop-down arrow and select the stereotype name. The stereotypes are
listed in alphabetical order.

Add Element to Diagram

This option is enabled when you have a diagram open. If you want the new element
to be added to a diagram, have that diagram open and select this checkbox.

Save

Click on this button to add the new element to the Browser window and, if
appropriate, the diagram.
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